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Welcome to the latest version of 2015 Knowledge-Based Audits: International Audits
(2/13/2015), the latest title available in the ProSystem fx® Knowledge Coach series!
Please review this bulletin prior to installation and use. If you have any questions, call Technical
Support at 1-800-PFX-9998, option 4.

Knowledge-Based Audits: International Audits is designed to help the auditor efficiently and effectively perform financial

statement audits of non-public international entities in accordance with International Standards on Auditing (ISAs). The knowledgebased audit is a risk-based methodology that emphasises using knowledge of the entity to make risk assessments in connection with
a financial statement audit. This allows the auditor to more appropriately focus audit efforts on those areas which in the auditor’s
judgement are the most significant and pose the most risk to the financial statement audit. The operations of international entities
are often unique and complex and require specialised accounting and auditing knowledge. This edition includes specific up-to-date
guidance for auditing international entities.
This guide includes interpretive guidance, workpapers, review programs, checklists, and correspondence necessary to complete
reviews of interim financial information in accordance with ISRE 2410, Review of Interim Financial Information Performed by the
Independent Auditor of the Entity, should this be required as part of the engagement.
Conducting audits of international entities requires the exercise of the auditor’s professional judgement. Additionally, the operations
of international entities are often unique and complex and require specialised accounting and auditing knowledge.
This document is published for the purpose of communicating, to users of the toolset, updates and enhancements included in the
current version. This document is not, and should not be used as an audit programme to update the audit documentation of an
engagement started in a previous version of this product.
This is the second update to this Knowledge Coach title. If you are updating from a previous version of this title, refer to the
Knowledge Coach User Guide Chapter 12. The guide is found on the Engagement File Room Help menu.
The 2015 documents include Accounting Research Material links to specific guidance that provides instant access to detailed analysis
related to the steps and processes discussed in the workpapers.

For more information on the Knowledge-Based Methodology and how it works within ProSystem fx® Knowledge Coach, refer to the
Additional Information section in this bulletin.

WORKPAPER NOTES
Important Note for Customers updating binders from the previous version of Knowledge Based Audits: International Audits
You must install Engagement 7.1, Knowledge Coach 2.1 and the 2014 Financial Statement Base Title before updating to the 2015
Knowledge Based Audits: International Audits. For more information on Engagement 7.1 and Knowledge Coach 2.1 or the 2014
Financial Statement Base Title, review the Release Notes and associated Knowledge Base article at the following link:
http://support.cch.com/answerdoc.aspx?id=sw43269

General Roll Forward Note
You must be the current editor of all Knowledge Coach workpapers to update to the latest content during roll forward, and you
must be the current editor upon opening the updated workpaper for the first time to ensure you see the updated workpaper.
The 2015 Knowledge-Based Audits: International Audits has been updated to help auditors conduct audit engagements in accordance
with the ISAs. The 2015 tools include links to specific guidance that provides instant access to detailed analysis related to the steps
and processes discussed in the workpapers.
The 2015 edition of Knowledge-Based Audits: International Audits has been updated to incorporate the 2013 Internal Control-Integrated
Framework (Framework) established by the Committee of Sponsoring Organizations of the Treadway Commission. The 2015 tools
include links to specific guidance that provides instant access to detailed analysis related to the steps and processes discussed in the
workpapers. Additionally, the 2015 edition of Knowledge-Based Audits: International Audits includes the following updates:
Specific Program Enhancements
The 2015 Knowledge-Based Audits: International Audits features numerous enhancements, including:
•
Additional tailoring to help distinguish more complex and less complex engagements
•
Streamlined process for when the auditor is not testing the operating effectiveness of internal controls
•
Materiality flow to audit programs and activity-level control workpapers
•
Findings are accumulated in the Internal Control Documents, including KBA-401 through KBA-412, to better
facilitate flow to KBA-103
•
Revised rule-of-thumb percentages in KBA-301. The benchmarks and related percentages are based on the
judgment of our expert authors. Our expert authors base them on issues encountered in practice, research studies,
AICPA audit risk and sampling guides, AICPA interpretive guidance (including AICPA CPE courses), and Big
Firm practices and policies. Based on this information, with regard to this toolset, the commonly used rule of
thumb amounts were revised to 1/2-2% for total assets and 1/2-2% for revenues earned
•
Reporting tool to assist the auditor in selecting the correct report
•
The audit area for related parties, commitments and contingencies, estimates, and concentrations has now been
separated into four audit areas
•
Updates to the KBA-400 series workpapers to facilitate the changes to the 2013 COSO framework
•
Several new forms and audit areas are available in this title including:
 AID-602 Understanding and Preliminary Assessment of the Entity’s Internal Audit Function
 AID-603 Component Identification and Analysis
 AID-842 Board Minutes Review Checklist
 AID-843 Dual Purpose Testing Worksheet
 AID-903 Audit Report Preparation Checklist
 AUD-908 Interim Review Program: Management Inquiries
 COR-202 Engagement for an Interim Review of Financial Information
 KBA-200 Entity Information and Background
For more information on specific program enhancements, review the 2015 International Overview for Knowledge Coach users
available at the following link or in the binder through the KCO-001 workpaper.
http://support.cch.com/updates/KnowledgeCoach/pdf/guides_tab/2015%20International%20Title%20Overview%20for%20Kno
wledge%20Coach%20Users.pdf

Additional Information on Knowledge Coach and the KBA Methodology
Knowledge-Based Audit (KBA) Methodology - Allows the results of one set of procedures to become the input for the next. The key components
of the KBA methodology include:
 An Overview that guides auditors through the methodology;
 Knowledge-Based Audit documents, integral to the risk assessment and overall audit processes, which contain steps and
procedures required by the ISAs;
 Customisable Audit Programmes that take auditors through related steps and procedures;
 Practice Aids to help auditors complete steps or processes outlined in the Knowledge-Based Audit documents and Audit
Programmes;
 Auditor’s Reports that provide a variety of sample auditor’s opinions on audited financial statements; and
 Correspondence documents that provide sample letters to be used to comply with ISA requirements and in many other
common situations.
The International Auditing and Assurance Standards Board’s (IAASB) Risk Assessment Standards - The practice aids and tools in the 2014
Edition of Knowledge-Based Audits: International Audits are designed around the IAASB’s risk assessment standards to assist
auditors of non-public international entities by:
 Facilitating compliance with ISAs;
 Encouraging more effective audits through tailored audit programmes and comprehensive practice aids;
 Helping auditors to focus on and respond to identified audit risks; and
 Enhancing audit documentation.

ProSystem fx® Knowledge Coach
ProSystem fx® Knowledge Coach functionality allows auditors to use the Knowledge-Based-Audit methodology more efficiently by
eliminating the need for duplicate entry of the same information, tailoring audit documentation to each particular engagement, and
documenting the link between risks identified and procedures performed. AUD-100 Tailoring Question Workpaper is a document in
Knowledge Coach that presents engagement-level questions designed to aid in tailoring the engagement documentation to fit each
client. Completing the questions helps the auditor avoid duplication and unnecessary workpapers.
Before you begin your audit, please review the guidance in AUD-101 Overall Audit Programme. This workpaper is intended to be your
road map through a Knowledge-Based Audit methodology. You should start your audit with AUD-100 Tailoring Question Workpaper
and AUD-101 Overall Audit Programme.
Risks can be captured via the Risk Summary task pane from any Knowledge Coach workpaper by the current editor of KBA-502
Summary of Risk Assessments. This allows the user to continuously assess risks during the engagement. Several workpapers prompt
the consideration of the presence of risks, but the Risk Summary task pane must be used to document those risks. All documented
risks flow to the Risk Summary. To ensure risks show in findings tables, make sure to check the “workpaper identified in” field of
the Risk pane.
Information Flow helps cut down on the time spent duplicating information across forms. In addition, the flow of consistent
information ensures that information and updates to information are not missed between workpapers. Drill-down functionality
helps the user navigate quickly to the source of the information, aiding in the review of the audit file.
Diagnostics help keep track of unresolved issues like unanswered questions, incomplete risks, programme steps not linked to risks or
relevant assertions, missing workpaper, and more. Diagnostics now show when a form table has not been answered (i.e. tables in
KBA-101 Overall Audit Strategy that are added by the tailoring questions in AUD-100 Tailoring Question Workpaper).
Links to Accounting Research Manager (ARM)-If you subscribe to an ARM library that includes audit content, you can link directly to
source material from Resources within Knowledge Coach documents. These links have been updated to reference to the accounting
standards under the FASB Accounting Standards Codifications and the auditing standards issued by the AICPA. Also, if you
subscribe to the Knowledge-Based Audits: International Audits Guide on ARM, you can take advantage of brand new links to the audit
guide material from within the Knowledge Coach documents.
Interpretive Guidance is integrated into each Knowledge Coach template through the Tips view of each new task pane. Informational
features include Practice Points, Examples, Optional Workpapers, and Resources to help auditors work more effectively and

efficiently. We have also added the ability to navigate from Resources within a document or the tip pane directly to CCH’s
Accounting Research Manager and industry audit guides by simply clicking on the Reference.

Important Notes




Make sure to save changes to workpapers before closing the workpaper or the binder to ensure data is correctly updated.
If your Current Editor Knowledge Coach MS Word workpapers become read-only or crash, please do the following:
o Keep the binder with the affected workpapers open.
o Highlight the workpaper in the binder window with and go to Tools>Save Knowledge Coach Answers
Knowledge Coach cannot be used within the Shared File Room (SFR) feature of Engagement. However, Knowledge Coach
workpapers can be shared across team members through check in, check out, workpaper assignment, syncing to the central
file room and through peer-to-peer sync in the same way other Engagement workpapers are shared.

System Requirements




This title MUST be used with ProSystem fx Engagement version 7.1, ProSystem fx Knowledge Coach version 2.1, and
2014 Financial Statement Base v4 and higher. If you are upgrading from ProSystem fx Engagement 7.0 or lower please
contact Technical Support at 1-800-PFX-9998, option 4 for detailed instructions.
A minimum of 4GB of RAM is required for optimal performance when opening and navigating through ProSystem fx
Knowledge Coach documents.

Download Instructions
Download the 2015 Knowledge-Based Audits: International Audits from the ProSystem fx Knowledge Coach Updates section of the
ProSystem fx Engagement Support Web site at the following URL: http://support.cch.com/updates/KnowledgeCoach, then select
the Knowledge Coach Series and Download file link next to the 2015 Knowledge-Based Audits: International Audits. On
some occasions the content package file (.KCP) has downloaded with the extension changed to .ZIP. If this occurs, please change
the extension of the downloaded file to KCP using all capital letters.
You must install the 2014 Financial Statement Base v4 title before installing the 2015 Knowledge-Based Audits: International Audits.
The Financial Statement Base title is also available at the following link: http://support.cch.com/updates/KnowledgeCoach
If you have already installed this title for 2014 Knowledge-Based Audits of Commercial Entities, ensure you have the latest
Knowledge Coach Content Update installed.
Important: ProSystem fx Engagement version 7.1 or higher and Knowledge Coach version 2.1 must be installed on the computer in
order to install this Knowledge Coach title. Additional requirements include Microsoft Office 2007, Microsoft Office 2007 Primary
Interop Assemblies (PIA) and Visual Studio 2005 Tools for the Office Second Edition Runtime, Visual Studio Tools for Offce
System Runtime version 3.0, and Visual Studio Tools for the Office System 3.0 Runtime Service Pack 1., Visual Studio Tools for
Office Runtime 4.0 (VSTOR) (32-bit version for 32-bit OS and 64-bit version for 64-bit OS).
The following 2015 Knowledge-Based Audits: International Audits (2/06/15).KCP download is a proprietary file that must be
installed from within Engagement. Save this KCP file to a location on your local drive, extract it, and follow the Installation
Instructions included in the Release Bulletin.

Installation Instructions
Once you have downloaded your Knowledge Coach title, you will need to add it to the list of titles within ProSystem fx
Engagement. The only additional system requirement is approximately 75MB of disk space to store your Knowledge Coach program
content files. Please refer to the ProSystem fx Engagement with Knowledge Coach Release Notes for any other system
requirements.

After downloading the 2015 Knowledge-Based Audits: International Audits titles, do the following:
1.
2.
3.
4.

Launch the ProSystem fx Engagement Workpaper Management application so that the Local File Room is
displayed. Select Tools > Knowledge Coach Titles.
The Knowledge Coach Titles window will be displayed.
Choose Add Title.
Browse to the title package file (*.KCP) that you previously downloaded and extracted from the ProSystem fx
Knowledge Coach Support Web site.
Choose Open.
The system will display a progress indicator while the title package is added. You will receive a message that the
title has been successfully installed once the process is complete.

Once the title is added, you must release it, so that other staff members in your firm can use it. You may also wish to “unrelease”
previous versions of the title.
To unrelease a title:
1.
2.

Select a version of the KBA International title.
Choose Unrelease Title. The date will be removed from the Date released column and staff that do not have the
staff group property right to insert unreleased titles will not be able to insert the unreleased titles into a binder.

Note: You can determine this access in the ProSystem fx Engagement Admin module by selecting a staff group and
choosing File > Properties > Content “Insert Knowledge Coach workpapers from unreleased titles” option.
To release a title:
1.
2.

Select one of the Knowledge Coach titles in the list that has been added but is not yet released.
Choose Release Title. The current date and time will be displayed in the Date released column, and the status will
change to “Released.”
Note: You must add and assign a Knowledge Coach module as well as the Knowledge Tools title license in the
ProSystem fx Engagement Administrator before using the workpapers.
Important: Once the 2015 Knowledge-Based Audits: International Audits titles have been added and released, they will be
automatically deployed to other staff members when they login to the “Office” location, or when they synchronize a binder
that contains Knowledge Coach workpapers from this title.

Online Permission Key
Permission key files may be downloaded from our Web site at

https://prosystemfxsupport.tax.cchgroup.com/permkey/download.aspx or when adding or updating the new licenses
within ProSystem fx Engagement with Knowledge Coach version 7.1 and higher. After updating the license file in the ProSystem fx
Engagement Admin module, licenses need to be assigned to the staff who will use 2015 Knowledge-Based Audits: International Audits.
If you have not already established a Single Sign-on (SSO) account with Customer Service, we urge you to do so at this time.
Permission keys are no longer generally distributed via floppy diskette. You can choose to continue receiving the diskette by going to
https://prosystemfxsupport.tax.cchgroup.com/service/accountadmin/ , clicking the Firm Administration link, and making
the appropriate selection (SSO access is required), or by contacting Customer Service at 1-800-PFX-9998, option 4.

Accounting Research Manager
CCH’s Accounting Research Manager is the most comprehensive, up-to-date and objective online database of financial reporting
literature. It includes all authoritative and proposed accounting, auditing, and SEC literature, plus independent, expert-written
interpretive guidance.

Our Weekly Summary email newsletter highlights the key developments of the week, giving you assurance that you have the most
current information. It provides links to new FASB, AICPA, SEC, EITF, and IASB authoritative and proposal-stage literature, plus
guidance from financial reporting experts.
Our team of content experts updates the system on a daily basis, so you can stay as current as possible. What’s more, our experts
attend critical, standard-setting meetings and summarize the results for you, which means you’ll learn of newly released literature and
deliberations of current financial reporting projects as soon as they occur! Plus, you’ll benefit from their easy-to-understand technical
translations. Our expert’s interpretations clearly lay out what the rules mean from your perspective.
Also available is the Knowledge-Based Audits: International Audits, a guide that helps you comply with the most recent professional
standards and guidance for the conduct of international audits and to integrate the use of practice aids, tools, and other resources
with its guidance. This publication supplements and complements the Knowledge-Based documents that are available in Knowledge
Coach.
With Accounting Research Manager, you maximize the efficiency of your research time, while enhancing your results. Learn more
about our content, our experts, and how you can request your free trial by visiting http://www.accountingresearchmanager.com.
You can also access the Accounting Research Manager Web site by selecting the item in ProSystem fx Engagement from the
Guidance tab on the Shortcuts bar in the Binder window.

Links to Accounting Research Manager (ARM)
As indicated above, subscribers to an Accounting Research Manager library that includes source content can link directly to source
material from references within Knowledge Coach workpapers. These links have been updated to reference the new Codification
released by the FASB and available on ARM. The Codification on ARM is fully integrated with U.S. and international accounting
standards, other non-authoritative materials and industry leading interpretive guidance.

Using Your Knowledge Coach Content
To use your Knowledge Coach Workpaper Templates,
open a binder in ProSystem fx Engagement, select the
workpaper tab into which you would like to insert the
workpaper, and select New Knowledge Coach
Workpaper from the toolbar or File menu. The New
Knowledge Coach Workpaper dialog appears (Figure 1).
Select the New Knowledge Coach Title with the
content you would like to use. You can only select titles
you have installed. The information displayed changes
to reflect the workpaper organization available for the
selected title. Select the Knowledge Coach Workpaper
Templates to insert into your binder and click OK. The
Selected Workpaper Properties dialog appears. Each
workpaper name is automatically loaded into the Name
field. Add a workpaper index in the Index field and
make any Name modifications you desire. You can also
modify the tab location or the roll forward settings for
each workpaper. Then click OK. The integrated
Knowledge Coach workpaper is now inserted into your
engagement binder. For more information on how to
use Knowledge Coach workpapers in your binder, see
the Knowledge Coach User Guide.

Figure 1 – New Knowledge Coach Workpaper

Download
Description:
Version:
Release Date:
File size:
Approx.
Download
Time:
License:
Platforms:
Office:

2015 Knowledge-Based Audits: International Audits
(2/13/2015)
Engagement v. 7.1 with Knowledge Coach 2.1 or higher and
2014 Financial Statement Base v4
February 2015
18MB
42 minutes at 56 kbps
Full Version
Windows Vista 7, 8 and 8.1
Microsoft Office 2007 required

Contact Information
For a demo or to purchase additional titles as they become available
Technical Support

1-800-PFX-9998, option 1
1-800-PFX-9998, option 4, then option 1

The ProSystem fx Engagement version of the Knowledge Coach Integrated Knowledge-Based Guides is sold and supported by
CCH, a Wolters Kluwer business. The contact information above can be used for customer service and support issues for this
product. For information about other CCH products, please call 1-800-248-3248 or visit the online Store at
http://tax.cchgroup.com.
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